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1. How to use This Manual

Using Microsoft® Windows®

Windows has many useful features. Refer to the Microsoft Windows User's Guide for more infor-
mation.

EDS EZ Help
Online help allows you to access context-sensitive information. Information is available by pressing
the F1 key When you exit help, you are returned to your original position.
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2. Installing EDS EZ

System Requirements
• 486/33 (ISA or EISA standards) with math co-processor and 8 MB memory 

• 80 MB hard drive (controller board must have a Western Digital or Goldstar chipset to use
Melco format disks)

• 3.5 inch disk drive, 1.44 MB capacity

• Super VGA Monitor 800 x 600, 16 color

• Melco Network Board and/or Ethernet Network Board

• Parallel port for Melco Security Dongle

• Mouse (Windows compatible)

• MS-DOS Ver 5.0 (or higher)

• Microsoft Windows 95 or 98

You must completely install all included hardware and software using the procedures on the fol-
lowing pages.

Hardware Installation for StarLAN Networks

Windows 95/98

If you are installing the system in Windows 95 or 98, install the card using the instructions below.

Check for Available IRQ and DMA settings

1. Click on Start→Settings→Control Panel.

2. Double-click on the System icon.

3. Select the Device Manager tab, the click Properties.

4. Make sure the Interrupt Request (IRQ) radio button is selected, then pick an IRQ that is NOT
listed on the screen. Write down your IRQ.

5. Click the Direct Memory Access (DMA) radio button, then select a DMA that is NOT being
used (the DMA must be either 0, 1, or 3). Write down your DMA.
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Configure your card

Now you must transfer your settings to the Network card (if applicable). The IRQ defaults to 11,
and the DMA (which comprises BOTH the DREQ and the DACK) defaults to 1. If you need to
change these settings, make your changes to the card. Be sure to change BOTH the DREQ and
DACK jumpers to change the value for the DMA.

Install the Network card

1. Turn the computer OFF and unplug it from the wall outlet. Remove the computer cover.

2. Discharge any static charge in your body by touching a non-painted area of the computer
frame.

3. Locate an empty expansion card slot.

4. Remove the expansion slot cover to the rear of the computer.

5. Remove the network board from the anti-static shipping bag.

6. Make certain the jumpers are placed correctly.

7. Insert the network board into the slot and press down firmly until the board is seated evenly
and completely.

8. Attach the network board to the rear of the computer frame with the screw from the cover
removed in step 4.

Figure 2-1
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11 (default)
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9. Replace the computer cover.

10. Turn the computer on and start Windows. 

Note: The following steps apply only to Windows 95 users.

11. Click on Start→Settings→Control Panel.

12. Double-click on the Add New Hardware icon. Let Windows 95 detect the new card.

Hardware Installation for Ethernet Networks 
The peripheral network in EDS III now supports two types of network protocols; Starlan and Ether-
net. Integrating an Ethernet network into the EDS III/peripheral network will offer many advan-
tages to Melco customers, including:

• Faster (up to 10X) network communication between system and peripheral

• Meaningful names for peripherals

• More reliable systems

If you have one or more EMC 10/12 or EMT peripherals, you have the option of connecting the
peripherals via an Ethernet network. With Ethernet, all your peripherals connect to a wiring hub.
The hub is a small electronic device that contains a number of cable jacks and diagnostic lights.
Refer to Figure 3-2 for a sample Ethernet network.

If your peripheral or computer is not equipped with an Ethernet network card, you must install a
compatible card in each to connect them. Refer to the documentation that was supplied with
your ethernet cards to install them in the peripheral or computer.
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Installing the Dongle

The dongle is a security device that must be
installed in an active parallel port of your computer.

1. Locate the parallel port LPT1 on the rear of your
computer. 

2. Turn the computer power OFF.

3. Secure the dongle with the captive screws.

Note: If you have a printer attached to your paral-
lel port, remove the printer cable, attach
the dongle, then reinstall the printer cable
to the end of the dongle when installation
is complete.

Attaching the Peripheral

See your embroidery peripheral operator manual for instructions on installing the network cable
from the computer to the embroidery peripherals.

Software Installation
Microsoft Windows must be installed prior to installing EDS EZ. If Windows is not installed,
refer to the Windows installation manual.

1. Insert the EDS EZ Program Disk 1 into the floppy disk drive.

2. Click on Start→Run (or File→Run if you are using Windows 3.x) to display the Run dialog box.

3. Browse to your 31/2 floppy drive.

4. Select setup.exe and click Open (or OK if you are using Windows 3.x).

5. Click OK and follow the on-screen instructions to install EDS EZ.

A message will appear warning that EDS EZ must be configured before use. Configuration is cov-
ered in the next section.

When the message displays instructing you to reboot the system, remove the disk from the disk
drive, exit Windows and turn your computer off. Wait 3 seconds and turn it on again.

Figure 2-2
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Configuring EDS EZ
Before starting EDS EZ for the first time, use the Config program to configure EDS EZ. Start
Windows and follow these steps to configure EDS EZ:

• To access the configuration program from Microsoft® Windows® 95, click on Start→→  Pro-
grams→→Melco Apps→→Config. 

• To access the configuration program from Microsoft® Windows® 3.x, double click on the
Config icon in the Melco Apps program group.

Note: If you are using a StarGate communications board, refer to the Stargate manual for proper
port settings.

10268 Rev. B 2. Installing EDS EZ
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Hardware Configuration

When you click on Hardware in the Configuration dialog box, the Hardware Configuration dialog
box appears (Figure 2-4).

There is a Platform, StarGate, and a Network section. Specify which IRQ (interrupt request) will be
used for each if you do not use the defaults. Remember to change the jumper settings if neces-
sary.

Advanced Configuration Options

Click on the Hardware... button to display the Advanced Configuration Options dialog box. To
enable the StarLAN network, click in the Enable StarLAN checkbox. To enable the Ethernet net-
work for the EMC 10/12, EP1B, or an EMT peripheral, click in the Enable Ethernet checkbox. The
default setting is for both networks to be enabled. 

Note: If a network is disabled, it will NOT function. If you have the NONETWORK option, be sure
to disable the StarLAN network.

The StarLAN board configuration may be tested by clicking on the Test Configuration push-but-
ton; a message will be displayed indicating success or failure of the card’s configuration.

Figure 2-4
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EMC 10/12

EDS EZ will not function properly on an EMC 10/12; Make sure the EMC 10/12 option is NOT
selected!

Setting StarGate options

If you have a StarGate multiport communications device, refer to its instruction manual. If you do
not have a StarGate, make sure Use COM Ports is selected.

Setting the StarLAN network options

In most cases, the default settings will work fine. Click on Default to accept these settings. If you
wish to customize the settings, select the appropriate values.

Note: No two pieces of hardware may use the same IRQ or DMA settings. These instructions for
installing the Melco boards work in most computers sold today without changing other
settings.

Setting the Ethernet network options (EMC 10/12 and EMT Only)

Server and client name(s) are only applicable to users running an Ethernet peripheral network. EDS
III is a server when the “Platform Selection” is set to EDS III or EDS EZ. EDS III is a client when
the “Platform Selection” is set to EMC 10/12. In an Ethernet environment, the client/server name
is used to identify the network components. You do NOT have to input the client or server name
(EDS III will assign one if necessary), but you may change the client or server name by clicking in
the “Client or Server Name” edit field (see Figure 3-9). The name should be limited to 16 charac-
ters.

The “Allow RSA Download” checkbox is only applicable to users running an Ethernet peripheral
network. RSA downloading may be enabled or disabled by clicking in the checkbox. In a network
with numerous servers, it may be useful to designate one server for RSA downloading.

Seeing which options are installed

Click on Options in the Hardware Configuration dialog to display the Set Options information box.
Options are in gray if installed or black if not installed.

If you encounter problems during software installation, call your Melco Representative
for assistance.
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3. An EDS EZ Overview

This chapter provides an overview of the operation and features of EDS EZ.

Starting EDS EZ

10268 Rev. B 3. EDS EZ Overview
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The Application Window
The Application window is the first screen EDS EZ displays. It has File, Peripheral, and Help in its
menu bar. Using these you can:

• Open a new layout window

• Open a file from a disk

• Import designs from non-DOS disks

• Send designs from the hard drive to the peripheral

File

Click on File in the menu bar and a drop-down menu (Figure
3-3) offers five options: New, Open, Import, Exit and a
Design List.

New opens an empty Layout Window.

Open requests information for retrieving a DOS file. A more
complete discussion of Open can be found in Chapter 7,
"Working With Designs".

Import requests information for retrieving a non-DOS
file.Exit closes EDS EZ and returns you to the Windows pro-
gram manager.

The Design List is at the bottom of the menu. The last six
open files are listed here. Clicking on a name opens that design in the Layout Window.

Peripheral

Click on Peripheral to access the Transfer dialog box, which allows you to send .EXP or .ASD files
directly to the peripheral.

Help

Provides information about the version of EDS EZ you are running. See Chapter 1 for more infor-
mation on how to use help.

Figure 3-3
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The Layout Window
Open the Layout window from the Application window by clicking on File then New. The menu
bar options are: File, Edit, View, Peripheral, and Help.

From the Layout window shown in
Figure 3-4 you can:

• Create lettering

• Add lettering to a design

• Open files from the hard disk
and DOS format disks

• Import designs from paper
tapes and non-DOS disk for-
mats (Melco, Tajima, Barudan,
Premier, and ZSK)

• Export designs to non-DOS
formats and paper tapes

• Save design files to the hard
drive

• Perform some customization
of designs

The File Menu

Click on File in the menu bar and the drop-down menu
(Figure 3-5) offers the following options; only the options
in bold are available.

New opens an empty Layout window.

Open requests information for retrieving a DOS file. A
more complete discussion of Open is in Chapter 7 "Work-
ing With Designs".

Close removes the design file from the active window.

Save allows you to save a new design or changes to an
existing design. If you are saving for the first time, the Save
As dialog box will appear and prompt you for a file name.
If you are saving changes to an existing file, the original file
will be overwritten.

10268 Rev. B 3. EDS EZ Overview
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Save As displays the Save As dialog box. It prompts you for information to save your current
design as a new file, or a second copy of an existing file. If you change a design, you may want to
keep both the original and the modified versions. Each must have a unique name. 

Import displays the Import dialog box.

Export prompts you for information necessary to copy a design file to a non-DOS disk or paper
tape.

Send transfers a design to a selected peripheral.

Print displays the Print dialog box.

Printer Setup prompts you for printer information. Clicking on Setup in the dialog box allows
you to change or update information about the selected printer.

Exit terminates EDS EZ and returns you to the Windows Program Manager after giving you an
opportunity to save any open files.

The Design List displays up to the last six opened designs.

The Edit Menu

Only commands in bold print are accessible (see Figure 3-6). Some
grayed-out commands will be available in other windows or when
screen objects are selected. 

Center Design places the design's center in the exact center of the
peripheral's sewing field. This is an important step before sending
designs to be sewn.

Return to Origin is on when a check mark appears next to it. Acti-
vate this option by clicking on it. It returns the needle to its origination
point when a design has finished sewing.

Cut, Copy, Paste and Clear are used to duplicate or delete designs or portions of designs.

Figure 3-6
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The View Menu

Only the bold commands in the View menu can be accessed (see Figure
3-7).

Regenerate redraws the design in the current window.

Ruler allows you to measure on-screen designs.

Zoom In enlarges a portion of the design on the screen. Select the area by
clicking and dragging the magnifying glass cursor over it. This is useful for
more precise editing. It does not affect sewing size.

Zoom Out decreases the design size on the screen. Select the area by
clicking and dragging the magnifying glass cursor over it. It does not affect
sewing size.

Zoom Last returns you to the previous Zoom view.

Fit Window redraws the design to fill the entire screen.

Actual Size draws the design on the screen at its sewing size.

Show Zoom Factor displays the current zoom factor on the status bar.

Tool Bar allows you to hide or display the toolbar.

Status Bar toggles the design information displayed at the bottom of the screen on and off.

Design Status displays stitch count, number of color changes, size of the design, and other sta-
tistics about the current design.

The Peripheral Menu

Status displays the Machine Status dialog box. This provides information on the status of the cur-
rently sewing job.
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The Layout Toolbar

The options in the toolbar allow you to customize your design and work with other features of
EDS EZ. They are represented by tools arranged down the left side of your screen as shown in Fig-
ure 3-8.

The Text tool displays the Text dialog box where you create let-
tering objects for your designs.

The Ruler tool allows you to measure a design in the Layout win-
dow.

The Zoom In magnifying glass enables you to look more closely at
a selected area of the current design

The Zoom Out magnifying glass enables you to see more of the
current design.

The Zoom Previous magnifying glass returns you to the previous
zoom level.

The Normal Cursor tool returns you to the standard arrow-type
cursor.

Figure 3-8
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4. Text Designs

Designs and alphabets are sometimes thought of as separate entities; but, alphabets are really a
set of designs. Normally there is a design for each letter, number, and punctuation mark in the
set.

The Text Tool
Creating text begins with the Text tool . Click on it and the Text dialog box displays.

The Text Dialog Box

The options in this dialog box affect the way your lettering displays on the screen and the way it
embroiders.

10268 Rev. B 4. Text Designs
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Density

In the EDS EZ Text screen, the density box refers to the space
between each line of stitching (see Figure 4-2). When this
space is decreased, the lines of stitching per inch increases. To
create more lines of stitching per inch, decrease the density
value. A general rule of thumb is:

• As design size increases, density value should
decrease

• As design size decreases density value should
increase

EDS EZ defaults to a density of 4.2 points (about 60 lines of
stitching per inch). This is a useful density for many applica-
tions. 

Note: Changing the density only affects column or satin stitches. Some alphabets are composed
of fill stitches and changing the density will not alter their appearance.

Length

Length refers to the underlay, walking, or running stitches used to move from one area of sewing
to another. These stitches are often covered by column stitching. Use the following as a guide:

Figure 4-2

Figure 4-3

Enter the density
here

Lettering Size
0.5 inch or greater

0.25 inch to 0.5 inch
0.25 inch or smaller

Running Stitch Length
30-40 points
25-30 points
20-25 points
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Line Type Options

There are five choices for line type:

• Line Center Middle

• Line Center Bottom

• Line Normal

• Arc Normal

• Arc From Center

You can sew in various types of arced or straight lines. Radius, Angle,
CW and CCW are used when sewing the arc line types.

Line Center Middle

Line Center Middle centers lettering both horizontally and vertically
around the needle starting and ending point (see Figure 4-4).

Line Center Bottom

Line Center Bottom centers lettering horizontally at the needle start-
ing point, which becomes the lettering baseline (see Figures 4-5). In
most alphabets the tails of the lower case letters such as g, j, p, q,
and y extend below the baseline.

Line Normal

Line Normal starts the lettering at the current needle position, which
is also the lettering baseline (see Figure 4-6). When the lettering is
finished, the needle will not return to its original position.

Arc Normal

Arc Normal sews lettering in a curve. The needle starting position is
the lettering baseline, with the text centered around the needle point
(see Figure 4-7).

Arc From Center

With Arc From Center, the needle position prior to sewing is at the
center of a circle that would be formed if the arc were completed.
The first needle movement is from that center point to the circumfer-
ence which is the lettering baseline (see Figure 4-8).
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Radius

Radius controls the degree of curve in an arc (see Figure 4-9). An arc is part of a circle's circumfer-
ence or edge. The radius is the distance from the center of the circle to the circumference. The
larger the radius, the flatter the curve.

Angle

Angle determines the location of the text
center point. It is entered in degrees, with
0 at the top of a circle, and 180 at the
bottom (see Figure 4-10).

CW (Clockwise) and CCW
(Counterclockwise)

Figure 4-11 shows to sew in a clockwise
direction when text is in the top half of a
circle and counter-clockwise when text is
in the lower half of a circle.

A
S

D F G

H
J

Radius = 0.25 inch

A

S D F G H

J
Radius = 0.75 inch

A S D F G H J

Radius = 1.0 inch

Figure 4-9

0˚
45˚

90˚

135˚
180˚

225˚

270˚

315˚

M e l c o

Figure 4-10

Angle=45°

0

90270

180

January

Feb
ru

ary

March

A
p

ril

CW 0˚ angle

CW
90˚ angle

CCW 180˚ angle

CCW
270˚ angle

Figure 4-11
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Spacing

Sometimes text is too crowded or too loosely
spaced. This often happens to arc lettering (see
Figure 4-12). Use the following techniques to
adjust spacing.

Uniform Spacing

At the Text dialog box, locate Spacing in the middle
right corner. Under Spacing is an option which
allows you to increase or decrease the distance
between all the letters in your text by a uniform
amount. With letters of 0.75 inches in height,
adding 0.10" helped the spacing, but the E M B let-
ters at the lowest part of the arc are still too close.
If more horizontal spacing is added, some of the
other letters would be too far apart. Now cus-
tomized spacing is needed.

Customized Spacing

Place the cursor between the letters needing space added, then
press F8. A » symbol appears between the letters (Figure 4-14).
Repeat as needed until spacing is adequate (Figure 4-15).

Each » adds a space equal to 1/16 of the letter
height. For example, with a 1" letter the space
would be 1/16". With a 0.5" letter, the space
would be 1/32".

Deleting Space with the F7 Key

You can decrease the space between letters that are too far apart in a similar manner. In the Text
dialog box, place the cursor between the letters that are too far apart and click. Press F7 and a «
symbol appears between the letters. Click OK to move the letters closer together. Each « subtracts
a space equal to 1/16 of the letter height.
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Line Spacing

Line spacing is defined as the distance from the bottom
of one line to the bottom of the next. A letter height of
1.0 inch with a line spacing of 1.0 inch makes the letters
from each line touch (see Figure 4-16).

Use the following formula to determine line spacing:

Vertical Spacing

Vertical spacing allows you to stair-step lettering up or
down. (This feature cannot be used with Arc formats.)
In the text dialog box, locate the Vertical option. This
value defaults to 0.00. Change the value and click OK
(see Figure 4-17). The top of each letter is to the right
and above the previous letter by the amount of space
designated.

Insert a negative value to stairstep down (see Figure
4-18).

Color Changes

A Color Change is an instruction to the peripheral to
pause for a rethread on a single-needle machine, or to
change to a different needle on a multi-needle
machine. It also changes the color in the Layout win-
dow to the next color in the palette.

To add a Color Change in the Text dialog box, place
the cursor between the letters and click, then press
the F6 key. A ^ symbol marks the Color Change as

Figure 4-16

Letter height + desired space between lines = Line Space

Figure 4-17 Figure 4-18

Figure 4-19
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shown in Figure 4-19.

Centering Text

The Center Design command recenters your design in the center of your peripheral's sewing field.
You can adjust the placement of the design at the peripheral before you begin to sew, but you
should always perform this step before sending a design.

To center the design, Click on Edit→Center Design.

Saving Text Designs

To save a design:

1. Click on File→Save As. The Save As dia-
log box displays as shown in Figure 4-20.

2. Type a name for the design in the Save
As File Name box.

3. Select a subdirectory (such as
EDSEZ\DESIGNS) or drive by double-click-
ing on it in the Directories box. You can
move back one level at a time by clicking
on [..].

Note: If you do not select a subdirectory,
your design will be saved in the EDS
EZ main directory (EDSEZ\).

4. Under File Type, click on Condensed, Object, or Expanded, then click on OK. File types are dis-
cussed in later chapters.
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The name of your file is now displayed in the EDS EZ title bar.
After the file has been named and saved once, you can resave
the file and any modifications by clicking on Save.

Monogramming

You can create a monogram in EDS EZ using either a monogram
alphabet or a regular alphabet in Monogram mode. Letters for
monograms are entered from the Layout window using the Text
tool and dialog box.

Using a Monogram Alphabet

To create a monogram using a monogram alphabet:

1. Click on the Text tool to display the text dialog box.

2. Select a Monogram Alphabet (for example, 3 LTR DIAMOND).

3. Type the initials (standard monogramming convention uses first, last, and middle initials in that
order).

4. Type in the Height of the center letter. The heights of the other letters are controlled by the
monogram alphabet.

5. Adjust the density as needed for the selected height.

Figure 4-21
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Note: Do not click the monogram box when using monogram alphabets. It is used when mono-
gramming with regular lettering alphabets. 

6. Click on OK to display the monogram (see Figure
4-21).

Monogramming With Regular Alpha-
bets

You can create a monogram using a regular alpha-
bet by following these steps:

1. Click on the Text tool to display the text dialog
box.

2. Select a regular alphabet.

3. Type in the initials.

4. Click on Monogram in the upper right quadrant of the Text dialog box, and the Monogram
Parameters dialog box displays (Figure 4-22). The numbers 1, 2 and 3 refer to the letters in a
monogram. Set number 2, the middle letter, at a height of 2.0 inches. Change the density, if
so desired.

5. Click on OK. Now Monogram is checked in the Text dialog box as an indication that you are in
the monogram mode and using a regular lettering alphabet.

6. Click on OK to display the monogram.

10268 Rev. B 4. Text Designs
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5. Working with Designs

Designs as Objects
When EDS EZ draws a design in the Layout window, that design is referred to as an object. Each
object is a separate item and maintains its own attributes. This allows you to have a mixture of
expanded and condensed designs in the same window. 

Using Cut, Copy, Paste, and Clear

The Cut, Copy, Paste, and Clear options are in the Edit menu and can be used with any object in
a selection box. The first three options work with the Windows clipboard, which is a temporary
memory area.

Cut copies the object to the clipboard and deletes it from the screen.

Copy copies the object to the clipboard but does not delete it from the screen. 

Paste copies the contents of the clipboard to the screen.

Clear deletes an object from the screen without copying it to the clipboard. Once an object has
been cleared it cannot be recovered.

You can also delete objects by clicking them, then pressing the [DEL] key on the keyboard. As with
clear, objects that have been deleted cannot be recovered.

An object remains on the clipboard until you end your EDS EZ session or until you Copy or Cut
another object. There can only be one object on the clipboard at a time. 
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Moving Objects In The Window

Click on the object, and a box with handles appears around it. Click and hold the object within
the box (not the box handles) using the left mouse button, and you can move the object any-
where in the active area of the window. You can also move an object in a single axis (either
up/down or left/right) by holding down the [Ctrl] key while using the mouse to click and drag.

Double-click on an expanded design and the Object Parameters dialog box (Figure 5-1) appears. ,

Double-clicking on a Condensed design brings up a different dialog box. You cannot move a Con-
densed design numerically.

Rotating Objects

Condensed Designs

To rotate a condensed design, click on the object
and drag handles appear. Click again and the han-
dles turn into arrows (Figure 5-2). Click on a corner
of the design with the left mouse button and drag
to rotate the design. The status bar displays the
degree of rotation.

Figure 5-1

Enter the new X and
Y position of the
object here

Figure 5-2

Arrows
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Expanded Designs

Expanded designs may also be rotated using the above procedure but may be rotated more pre-
cisely using the dialog box. Double-click on an expanded design to display the Object Parameters
dialog box (Figure 5-3).

Changing the Orientation of a Design

Sometimes design orientation must be altered for proper results. Figure 5-4 shows the various ori-
entations available.

To change orientation, refer to
these instructions.

1. Click on the Object Parameters
tool to display its dialog box.

2. Click on the F under Orientation until the desired orientation displays.

3. Click on OK.
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Figure 5-3

Enter the degree of
rotation here; positive
values rotate objects
counter-clockwise and
negative values rotate
the object clockwise

Click here
to accept
changes

Click to insert a trim
command after a
design

Click to insert a color
change command
after a design

Click here to lock an object; a
locked object may not be
moved or scaled

Figure 5-4
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Deleting an Object

EDS EZ gives you the flexibility to delete an object in two different ways.

The Layout Window

1. Click on the object.

2. Press [DEL] on the keyboard.

The Menu Bar

1. Click on the object.

2. Click on Edit in the Menu Bar.

3. Click on Clear.

Centering a Design

The Center Design command recenters your design in the center of the sewing field. You can
adjust the placement of the design at the peripheral before you begin to sew, but you should
always perform this step before sending a design. To center the design, click on Edit, then Center
Design.

Scaling Designs

Condensed designs can be increased in scale by up to a factor of three and reduced by as much
as a factor of 0.2. Perform a test sewout if you dramatically change a design’s scale.

Rescaling a condensed design adds or subtracts stitches to or from the design. Rescaling an
expanded design does not.
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Scaling a Condensed Design

To scale a condensed design, click on the object and drag handles appear (Figure 5-5). Click on a
corner of the design with the left mouse button and drag to scale the design. The status bar dis-
plays the new relative proportions.
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Figure 5-5

Scales X axis only

Allows propor-
tional scaling

Scales Y axis only
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Scaling an Expanded Design

Expanded designs may also be scaled using the above procedure but may be scaled more precisely
using the dialog box. Double-click on an expanded design to display the Object Parameters dialog
box (Figure 5-6).

Figure 5-6

Click here to use customized scaling in
both X and Y directions (i.e., X=1.5 and
Y=0.5)

Enter the new scale
here; if Scale XY is NOT
checked, Y will auto-
matically be scaled the
same as X

Click here to apply
the new scaling

Click here to cancel
the new scaling
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Modifying Condensed Designs
EDS EZ allows you to modify the way a condensed design sews. This applies to condensed designs
only.

Follow these steps to modify a condensed design:

1. Load a .CND file into the Layout window.

2. Double-click on the object to display the Adjust dialog box (Figure 5-7).

Stitching

Length

Length refers to the walking or running stitches used to move from one area of sewing to anoth-
er. These stitches are usually covered by column stitching.

Max. Length

Enter the maximum stitch length up to 127 pts. The default is 127 pts.
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Figure 5-7

Adjust length of run-
ning stitches here

Sets the max
length of a stitch
before it triggers a
jump stitch

Turns short stitch-
es on or off

Turns lock stitches
on or off

Set column density and
width here

Turns underlays on or off
and sets parameters

Allows changes to scaling (relative proportions) of a
design’s density, stitch length, fill density (if applicable) and
fill stitch length (if applicable)

Resets all options
to EDS EZ
defaults

Click here when
finished
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Short Stitch On

Short Stitch sews less than the full column width on the inside of a curve or corner. This prevents
repeated needle penetrations in one spot. The default is On.

Lock Stitch On

Lock Stitch On sews three small stitches at the end of a letter to tack the stitching. The default is
Off. If the design already features lock stitches, enabling this command will add three more.

Column

Density

This is the space in a column between the lines of stitching. The value is entered in points.

Width

Width allows you to increase or decrease the width of the individual column. The height may also
be slightly affected. The value can be changed in increments of 10%, from +70% to -70%.

Fills

Fills converts column stitching to fill stitching. Instead of a single stitch across the entire width of a
column, there are a series of shorter stitches. Turn on Fills when letters are too large for column
stitching to be durable. Fills applies to all Alphabet, Monogram, and Design File column stitches.

Stitch Length

This sets the length of Fill stitches. The default is 40 points.

Line Sequence

When there are multiple stitches in a column, they can sew one directly under the other, or in a
staggered pattern. Line Sequence determines where the needle penetrations will be on each line.

Underlay

Turning Underlay On allows you to choose one of the three types of underlay for column stitch-
ing. Underlay works with Alphabet, Monogram, or Design files, but will not sew beneath fill
stitching.

Stitch Length

Length sets the underlay stitch length for Edge Walk and Center Walk.
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Density

This is the underlay density for Narrow Column. The range is 2.6 to 84.7 pts.

Width

This is the underlay width by a percentage of the column width from 40% to 95%. It applies to
Narrow Column and Edge Walk underlays.

Scaling

This section allows you to change densities and stitch lengths by a percentage of the existing val-
ues. It does not change the overall size of the design.

Density

Density resets column density. Values over 1 increase the density and decrease the stitching cover-
age. Values less than 1 decrease the density and increase the stitching coverage.

Stitch Length

Stitch Length resets running stitch length based on a scale factor rather than points. A value of 2
doubles the stitch length, a value of .5 halves the stitch length.

Fill Density

Fill Density resets the density of fill stitching. Values over 1 increase the density and decrease the
stitching coverage. A value less than 1 decreases the density and increases the stitching coverage.

Fill Stitch Length

Fill Stitch Length resets fill stitch length. A value of 2 doubles the stitch length. A value of .5
halves the stitch length.

Modifying Expanded Designs
Double-click on an expanded object to display the Object Parameters dialog box. Following is a
description of the options:

Lock Object

If you have a mixture of text and a design, this will "lock" the objects together.
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Trim After

This will place a trim at the end of a design sewout.

Color Change After

This will place a Color Change command at the end of a design sewout.

Design Notes
This feature allows you to add notes to any Object (OFM) file. 

Note: This option only works with Object files. It will not work with Expanded or Condensed
files.

To access the notes feature, click on File→Notes. The Notes dialog box (Figure 5-8) appears.

Figure 5-8

Type text
here

Click to print notes

Click to cut, copy, or
paste notes to or
from multiple designs
or other Windows
based programs

Click here to
save notes

Click here
to erase notes

Click here to exit
without saving notes
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Print
This feature allows you to print information about the currently loaded design to a connected
printer. To access this option click on File, then Print. The Print dialog box (Figure 5-9) appears.

Design, Status, and Notes prints the current design, status, and any notes associated with the
design.

Print Design prints the current design as shown on-screen.

Object List prints the name of all objects within the current design, their location, and orienta-
tion.

Design Status prints the size, location, and number of stitches (total stitches and total each
color), and other information for the current design.

Notes prints the notes associated with the current design.

Using the Color Palette
EDS EZ allows you to choose the colors
used to draw your designs on the
screen. When the palette bar display is
on as shown in Figure 5-10, the colors
are shown at the bottom of the Layout
window. By changing these colors, you
get a preview of a sewn garment. 

EDS EZ begins drawing with the first
color in the palette bar and moves
once to the right each time a color-
change command is encountered. EDS
EZ refers to the colors as "Needle 1",
"Needle 2", etc., but they do not con-
trol which needles are used at the
sewing peripheral.
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Figure 5-10

Palette

Background
color

Figure 5-9

Click here for a list of
printable items
(described below)

Change the number
of copies here

Click to print

Click to cancel

Select whether the design
should be printed at actu-
al size or scaled to fit the
page
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24 needles are available in the color palette bar. The screen background color is permanently
located in the last, outlined box on the right end. The screen color can be changed the same way
you control the needle colors.

Working with the Palette Bar

In the Layout window, double click any colored square (called “needles”) to display the Needle
dialog box (Figure 5-11.

Figure 5-11

Displays the color
EDS EZ will displayShows the relative

composition (dither-
ing) of the color

Use the scroll bars or
type in the value to
increase or decrease
a color’s presence

Name a color (to
save it) here

Click to save the
current color

Click to delete a
selected color

Click to accept
changes

Click to cancel
changes
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Color Information

The Red, Green, and Blue color values are in a range of 0 to 255. To see these colors on a 16-
color monitor, enter their numerical values in the needle dialog box.
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Red Red - 255 Green - 0 Blue - 0

Green Red - 0 Green - 255 Blue - 0

Blue Red - 0 Green - 0 Blue - 255

Yellow Red - 255 Green - 255 Blue - 0

Magenta Red - 0 Green - 255 Blue - 255

Cyan Red - 255 Green - 0 Blue - 255

Reddish Brown Red - 128 Green - 0 Blue - 0

Darker Green Red - 0 Green - 128 Blue - 0

Darker Blue (Navy) Red - 0 Green - 0 Blue - 128

Ocher (Pale Yellow) Red - 128 Green - 128 Blue - 0

Turquoise Red - 0 Green - 128 Blue - 128

Violet Red - 128 Green - 0 Blue - 128

White Red - 255 Green - 255 Blue - 255

Gray Red - 128 Green - 128 Blue - 128

Light Gray Red - 192 Green - 192 Blue - 192

Black Red - 0 Green - 0 Blue - 0
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6. Working With Files

This chapter covers opening existing files, importing files from other formats, saving new files, and
exporting new files to other formats.

Design Formats
Disks come in a variety of storage formats, but EDS EZ considers them as either a hard disk (DOS)
or a floppy disk. EDS EZ can access both, but uses different commands with each as shown in the
following table:
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To perform this
operation

Use this command

For DOS formats For non-DOS formats
Load design file into EDS EZ Open or Import Import

Save to hard drive (all files saved
on the hard drive are DOS

formats)

Save or Save As N/A

Save to floppy disk Save, Save As, or Export Format the disk
appropriately, then Export
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Opening Designs
Refer to Figures 6-1 and 6-2 to open a file.

Figure 6-1

Click on
File

Click on
Open

Figure 6-2

Click here to display
all directories for the
specified drive

Select the drive and
directory where the
file is located

Click on the file
name

Click on OK
when finished
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Importing Designs
Some of the designs you work with may be on a floppy disk. EDS EZ is compatible with DOS,
Melco, Premier, Tajima, Barudan FDR and FMC, and ZSK disks, all of which have unique formats.
The following chart outlines when to use each command.

To import a design, click on File, then Import. The Import dialog box (Figure 6-3) displays.

Note: If you click on the Options button while working with a Tajima format disk, a message box
will ask you if you want to update the Boot Record of the disk. This refers to some Tajima
disks that have an improper internal label and cannot be read by a DOS computer. If you
have problems loading a Tajima disk, click on the Options button and respond Yes to the
message.
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Figure 6-3

Click on the device reading the disk (or
reader if reading from a paper tape)

Click on the
proper format

Click to read the
disk’s directory

Select the file to
import from the
list of files

Click to import
the file
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Saving Designs
To save a design: 

1. Click on File in the menu bar.

2. Click on Save As in the drop-down menu. The Save
As dialog box displays as shown in Figure 6-4.

3. Type a name for the design in the Save As File Name
box.

4. Select a subdirectory or drive by double-clicking on it
in the Directories box. You can move back one level at a time by clicking on [..].

Note: If you do not select a subdirectory, your design will be saved in the EDS EZ main directory.

5. Under File Type, click on Condensed, Object, or Expanded, then click on OK. File types are dis-
cussed in later chapters.

The name of your file is now displayed in the EDS EZ title bar. After the file has been named and
saved once, you can resave the file and any modifications by clicking on Save.

File Types

The term file type refers to the way design data is coded and named. In EDS EZ there are four
file types: Expanded, Condensed, Object, and Auto Send.

Expanded Files

An Expanded design file contains instructions for each individual stitch. Modification of an
expanded design is much more limited than modification of a condensed design. Once you save a
file as Expanded, you cannot change it to Condensed. Expanded file names have the extension
EXP. 

Condensed Files

A Condensed file contains summarized design instructions. Its format allows the design to be
rescaled and its density and stitch length modified. Condensed file names have the extension
CND.

Figure 6-4
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Object Files

An Object file contains information about multiple objects, each with its own separate instruc-
tions. For instance, you might combine into one Object file:

• An Expanded design of a team mascot

• A Condensed design of team member's name

Then, you can modify each object separately. You could rescale the name without altering the
mascot. Object file names have the extension OFM.

Auto Send Design Files

An Auto Send Design file is created by EDS EZ when transferring or sending files to a peripheral.
In addition to your design data, the file contains special instructions added by EDS EZ to help the
peripheral make a sewing recovery after a power failure. Auto Send Design files have the exten-
sion ASD.

ASD files are stored in the EDSEZ\ASD subdirectory. To prevent this directory from taking up too
much of your hard drive, delete old files periodically using the Windows File Manager. For more
information on how to use File Manager, consult your Windows User Manual.

Exporting Designs
Click on File, then Export to display the Export dialog box (Figure 6-5).
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Figure 6-5

Select the correct format Select the correct device

Insert a disk
into the proper
drive, and click
to export

Enter name
of new file
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Note: If you are unsure of the format, click on
Unknown, then on the Directory button. EDS EZ
will determine the format of the disk and make
the selection for you. If you selected a Format
Type that does not match the format of the disk,
the error message shown in Figure 6-6 will be
displayed. If you are still unsure of the disk’s for-
mat, click on Unknown.

File Name Standards
The filename conventions for floppy disk formats are
given below. These rules must be followed for the disk to be read by other systems:

DOS Format

DOS format names consist of a 1-8 character filename and one of the following extensions:

.CND - Condensed Format

.EXP - Expanded Format

.OFM - Object (Layout format)

Barudan FDR Format

Barudan FDR uses a numeric format. The file number can be from 1 to 36. In addition, a label of
up to 8 characters may be specified with this file number. The number and the label must be sep-
arated by a colon.

Examples:

3

26:SNAIL

Barudan FMC Format

Barudan FMC uses a numeric format. The file number can be from 1 to 36. No character labels
are allowed.

Examples:

3

26

Figure 6-6
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Melco Format

MELCO format names consist of a 1-6 character filename and one of the following extensions:

.CND - Condensed Format

.EXP - Expanded Format

Premier/Stellar Format

The PREMIER/STELLAR format uses the Indirect mode of specifying file names (see your Premier or
Steller manual for a description of Indirect mode). In general, you can think of a Premier/Stellar
filename as a number between 1001 and 1999.

Examples:

1001

1930

The Options button allows you to specify 5 different sizes for the hardware scaling of the design
at sewout time. The defaults are:

Smallest: 50%

Smaller: 75%

Larger: 125%

Largest: 150%

Enter new sizes as a ratio to 1.00, for example 125% is entered as 1.25

Note: The Stellar 1 can only read files saved in this format. The Premier can read Tajima and DOS
(.EXP) files as well.

Tajima Format
Tajima format uses a numeric format with numbers ranging from 1-999. Beginning with EDS EZ
release 1.32, any 1-8 character name is also supported. In addition to a filename, a 1-8 character
label can be specified after the filename and separated by a colon (like the Barudan FDR format.)

Examples:

1

G001 (How the old Tajima format stored the name 1)

1:TEST

APPLE:TEST (The new Tajima Format)
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ZSK Format
Zsk format uses a numeric format with numbers ranging from 1-999.

Examples:

1

12
234
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7. Working with Peripherals

Enabling a StarLAN Peripheral
StarLAN peripheral(s) must be enabled before a design is sent. To enable the peripheral, Click on
File, then Transfer to display the Transfer dialog box (Figure 7-1).

Note: If you are operating an Ethernet EMC 10/12, it does NOT need to be enabled.

Before sending a design to the peripheral, make sure
the following apply:

• The computer network cable is connected to
the peripheral

• The peripheral's power is ON

• The peripheral software is downloaded

Note: The peripheral MUST be set to the same
number. Refer to the machine Operator man-
ual for information on how to properly con-
figure the machine.

10268 Rev. B 7. Working With Peripherals

Figure 7-1

Click here to display
the Peripheral Setup
dialog box (Figure
7-2)

Figure 7-2

Click on the peripheral number
to enable it (if it is highlighted, it
is enabled), then click OK
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Sending Designs
Designs may be transferred to the peripheral(s) one of two ways.

Using Transfer

Click on Peripheral, then Transfer to display the Transfer dialog box (Figure 7-3).

Figure 7-3

Select file typeSelect directory

Select file
name

Select peripheral where the
design will be sent

Select whether the design
is auto run or auto delete

Sends the file cur-
rently open in the
Layout window

Click to send the
specified file to
the peripheral

Click to return to
the Layout window

Click to
cancel
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Using Send

Click on File, then Send to display the Send dialog box (Figure 7-4).
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Figure 7-4

Select the peripheral

Click here to automati-
cally queue the design
at the peripheral

A name will be selected for the file (as it will
appear at the peripheral); to change the
default name, type the new name here

Click here to have the
design automatically
delected once it has
sewn.
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Checking Peripheral Status
EDS EZ continuously surveys each peripheral for statistical data. This data is available on the
Machine Status screen. To access the information click on Peripheral, then Status to display the
Machine Status screen (Figure 7-5).

Figure 7-5

Displays enabled
peripherals and status

Lists designs in the job
queue

Shows which
peripheral is
being polled

Color sequence list
(99 colors max)

Color being sewn
Shows the number of thread
breaks

Length of
time the
peripheral
has been
turned on

Length of time the
peripheral has sewn

Remaining
space in
job queue

Current
or last
sewing
speed

Name of cur-
rent or last job

Length of
time current
or last job ran

Stitch count
in current or
last job

Indicates
percent com-
pleted of
current job
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Detail

This option is available for peripherals designed to relay this information. It appears grayed out if it
is not available. Click to display the Thread/Bobbin Breaks information screen (Figure 7-6). Thread
Breaks: Displays the thread breaks on each needle.
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Figure 7-6

Toggles information dis-
played above to each
different category

Displays information
for each needle

Select counter (by
day or by job)

Saves current counts
to an ASCII text file

Resets all counters to
zero

Updates counters
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Client/Server List

The Client/Server list is only applicable to
users running an Ethernet network.

Click on Peripheral→Client/Server list to
display a dialog box (Figure 7-7) showing
all servers and peripherals (called clients)
online. The dialog box is for informational
purposes only. It displays each server and
client’s name, Ethernet address, and which
Ethernet network it is on. Servers that are
capable of downloading RSA files are
marked with a * symbol. Click on the
Update button to poll the networks for
new information. Figure 7-7
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